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Manual Layout

This document is a reference manual for eZ-PostView’s Menu options, associated Toolbar buttons, and
resulting GUI screen images.

The document is arranged as follows:

Introduction

Ch 1 – Getting Started with eZ-PostView lists system requirements and provides instructions for
installing eZ-PostView onto a PC.

Ch 2 – eZ-PostView Menus and Windows explains the Menus, software buttons, and windows that are
part of eZ-PostView’s Graphical User Interface (GUI).

Ch 3 – Interactive Features of eZ-PostView’s Plot Display Window explains how to change plot display
characteristics, including display functions, by using the interactive features of the display window.

Appendix A – Keyboard Controls identifies keys for controlling plot display, menus, windows, and
record/playback functions for the eZ-Analyst program from which eZ-PostView was derived.  Many
of the key controls can be used with eZ-PostView.

Check the README.TXT file for information that may not have been available at the
time this manual went to press.
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Introduction

eZ-PostView Can Be Used without the Presence of Acquisition Hardware

eZ-PostView is a time-domain post-acquisition data
viewing application that has been integrated with
primary data acquisition software, including
DaqView, Personal DaqView, ChartView, LogView,
and WaveView.

The eZ-PostView application provides easy-to-use
post-acquisition analysis capability, and is included
free of charge as a part of product support. From
this application you can display up to 8 time-
domain function windows and display up to 16
channel traces per window.  Data is automatically
scaled to optimize its fit in the window.

From eZ-PostView you can customize window,
channel trace, and cursor colors. A Screen Capture from eZ-PostView

Once installed, eZ-PostView can be launched from the data-acquisition program by a simple click of the
<View Data> button.  As an alternative, the application can be launched independent of the acquisition program and
supported data files can be loaded for viewing.

eZ-PostView includes the following features:

• File Input Format Support for: DaqView, WaveView, Personal DaqView, ChartView,
Universal File Format UFF-58B.

• Can show 8 Display Windows simultaneously

• Can show 16 Channel Traces per Display Window

• Includes Automatic Data Scaling

• User-Configurable Data Display is provided for channels and trace colors

• Allows for multiple Tiling, or Cascading, of display windows
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eZ-PostView makes use of buttons similar to those found on VCRs.  As indicated by the following figure,
you can select to play the data display forward, backward, or frame by frame in either direction.  The
playback task bar is located just below the menu bar, which is detailed in chapter 2.

Playback Task Bar

Play Backward,                 Play Backward        Stop       Play             Play Forward
One Frame at a Time                                                                          One Frame at a Time
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Getting Started with eZ-PostView 1

System Requirements …… 1-1
Software Installation …… 1-2

System Requirements

Your computer should meet the following minimum requirements.

• Intel™, Pentium 90 MHz or equivalent
• 64 MB Memory
• 100 MB Hard Disk space
• Monitor: SVGA, 800 x 600 resolution
• One of the following Microsoft® Windows Operating Systems:

Windows 98
Windows Me
Windows NT
Windows 2000
Windows XP

If you purchased software, associated authorization codes will accompany your
installation CD.  If this is the case, keep your codes in a safe place.  You will need to enter
them once, during an actual run of the purchased software.

Note that no authorization code or password is needed to run eZ-PostView.
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Software Installation

Before installing a version of our data-acquisition software, remove all
previous versions of that software.

Reference Notes:

➣ Adobe Acrobat PDF versions of documents pertaining to your system hardware and
software are automatically installed onto your PC’s hard-drive as a part of product
support at the time of software installation.  The default location is the Programs group,
which can be accessed via the Windows Desktop Start Menu.

➣ PDF versions of documents can be read directly from the data acquisition CD.

➣ After your software is installed you can setup your data acquisition device, e.g.,
WaveBook, DaqBook, LogBook, and connect it to the host computer.  Instructions for
hardware setup are included in your device user’s manual, which is included on the CD.

When you first install software for your acquisition device, eZ-PostView will automatically be selected for
installation along with the primary acquisition software application.  For example, when a WaveBook is selected,
both WaveView and eZ-PostView will show as pre-selected software options.

To install eZ-PostView …

1. Start Windows.

2. Close all running applications.

3. Insert the Data Acquisition CD into your CD-ROM drive and wait for the CD to auto-run.

If the CD does not start on its own:

(a) click the desktop’s <Start> button
(b) choose the Run command
(c) select the CD-ROM drive, then select the setup.exe file
(d) click <OK>

An Opening Screen will appear.

4. Click the <ENTER SETUP> button.

5. On the hardware selection screen [which follows a licensing agreement], select your hardware from the
drop-down list.

6. On the resulting software options screen, select the software that is applicable to your system.
Note that eZ-PostView is already selected by default.

7. Click the <Install> button; then follow the screen prompts to complete the installation.
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You will be prompted to enter an Authorization Code.

➣ If you purchased eZ-TimeView or eZ-FrequencyView enter the code for the
associated application; then click the <Apply Code> button.

➣ If you are installing eZ-PostView [which requires no code], simply click the
<OK> button or, if you prefer, click the <Start 30 Day Trial> button to try out
the more powerful eZ-FrequencyView Application.

Authorization Dialog Box

Note:   Entry of your Authorization Code is only required once.  However, you can enter a new code
at a future date, for example, if you wanted to upgrade from eZ-PostView to eZ-FrequencyView.

To open the Authorization Dialog Box:

1. Open eZ-PostView.  You can open eZ-PostView by clicking the <ViewData> button
in your primary data acquisition program, e.g. WaveView, DaqView, LogView, etc.

2. From eZ-PostView’s File Pull-Down menu, select Authorization (following figure).
The Authorization dialog box appears.

File Menu

To enter a code:

1. Type-in the code, as it appears on your Authorization Sheet.

2. Click the <Apply Code> button.
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eZ-PostView Menus and Windows 2

Contents

Features of eZ-PostView …… 2-1
File Menu …… 2-3
Edit Menu …… 2-4

Configuration Window …… 2-4
Acquisition Tab…… 2-5
Channels Tab …… 2-6

Playback Setup Window ……  2-7
Window Colors Window……  2-8
Preferences Window …… 2-9

Window Menu ……  2-11
Add Function View (FV) …… 2-11
Delete Window …… 2-11
Channel Buttons …… 2-11
Cascade ……  2-12
Tile Vertically …… 2-12
Tile Horizontally …… 2-13
Refresh Windows …… 2-13

Features of eZ-PostView
The free eZ-PostView application includes the following features.

• File Input Format Support for: DaqView, WaveView, Personal DaqView, ChartView, UFF-58B.

• 8 Display Windows

• 16 Channel Traces per Display Window

• Automatic Data Scaling

• Configurable Data Display for channels and trace colors

• Multiple Tiling of display windows

Note that eZ-PostView was derived from a much more versatile eZ-Analyst program.  A comparison of
eZ-PostView features to those of eZ-Analyst and 2 other derived applications appears on page 2-2.

As indicated by the following table, many features do not apply to eZ-PostView.  In the screen images, both those of
the actual application and those presented as figures in this manual, information that does not apply to eZ-PostView
is either “grayed-out” or “hidden.”  The same applies to functions of the pull-down menus.

Reference Note:
The document, eZ-Analyst Series Software Reference, p/n 1086-0922 contains information that is
applicable to the higher-level “view” programs eZ-TimeView and eZ-FrequencyView, and to eZ-Analyst.
The eZ-Analyst Series document includes information regarding the Miscellaneous and the Octave Tabs,
which do not apply to eZ-PostView.
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Comparing eZ-PostView to other eZ-Analyst Series Applications

 eZ-Analyst Series Comparison Matrix

Post-Acquisition Viewing PackageFeature
eZ-PostView eZ-TimeView eZ-FrequencyView

eZ-Analyst

File Input Format Support for: DaqView, WaveView,
Personal DaqView, ChartView, UFF-58B.

Yes Yes Yes Yes

File Export to: ME’Scope and SMS Modal, Microsoft
Excel, Binary Universal File, and ASCII text files.

----- Yes Yes Yes

Display Windows, number of 8 8 8 8

Channel Traces per Display Window 16 16 16 16

Automatic Data Scaling Yes Yes Yes Yes

Simulated Data Playback ----- Yes Yes Yes

Configurable Data Display for channels and trace colors Yes Yes Yes Yes

Multiple Tiling of display windows Yes Yes Yes Yes

Cursor Support - for both Single Cursor and Band Cursor ----- Yes Yes Yes

Data Strip Chart Display ----- Yes Yes Yes

Peak-to-Peak Calculations ----- Yes Yes Yes

Peak Searching, minimum and maximum ----- Yes Yes Yes

Mean Calculations ----- Yes Yes Yes

RMS Calculations ----- Yes Yes Yes

Zooming [of the data display] ----- Yes Yes Yes

Windowed Time Display Function ----- Yes Yes Yes

Cross Channel Support ----- ----- FFT, FRF, Cross,
Coherence,

Transfer Function

FFT, FRF, Cross,
Coherence,

Transfer Function

Transfer Function Display Types ----- ----- Note 1 Note 1

Complex Function Display Types ----- ----- Note 2 Note 2

Scale Types ----- RMS, Peak,
Peak-to-Peak

RMS, Peak,
Peak-to-Peak

RMS, Peak,
Peak-to-Peak

Function Display Types ----- Time, Strip
Chart

Note 3 Note 3

Octave Types ----- ----- 1/3, Full 1/3, Full

Octave Weighting ----- ----- Linear, A, B, C Linear, A, B, C

Waterfall Plots ----- ----- Yes Yes

Integration/Differentiation (Single/Double) ----- ----- Yes Yes

Response Channel FFT Windows ----- ----- Note 4 Note 4

Reference Channel FFT Windows ----- ----- Rectangular,
Cosine Taper

Rectangular,
Cosine Taper

Low-Pass DC Noise Filtering ----- ----- Yes Yes

Spectral Strip Chart Display Synchronization ----- ----- Yes Yes

Octave Strip Chart Display Synchronization ----- ----- Yes Yes

Record and Save Data to Disk ----- ----- ----- Yes

 “Real Time” Data Display ----- ----- ----- Yes

Notes:     1)  eZ-Analyst and eZ-FrequencyView  - each offers the following Transfer Function Display Types: Inertance, Mobility,
Compliance, Apparent Mass, Impedance, and Dynamic Stiffness.

2) eZ-Analyst and eZ-FrequencyView - each offers the following Complex Function Display Types: Magnitude, Phase, Real,
Imaginary, Nyquist, Magnitude and Phase, and Real and Imaginary.

3) eZ-Analyst and eZ-FrequencyView - each offers the following Function Display Types: Spectrum, Auto-Spectrum,
PSD (Power Spectral Function), Strip Chart.

4) eZ-Analyst and eZ-FrequencyView – each offers the following Response Channel FFT Windows: Hanning, Flat Top,
Exponential, and Blackman-Harris.
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File Menu

The File Menu provides a means to print plotted data, as well as open and save data files.

Open Data File … (.thd or .dsc)

Used to locate and open saved files. ZonicBook uses files with .thd extensions.  View applications, i.e.,
WaveView, DaqView, Personal DaqView, LogView, and ChartView use files with .dsc extensions.

Save Plot Setup (PSET) …

These two menu items provide a means of saving [or opening] function files. Time and auto-spectrum data
is saved. If there is any reference channel cross-spectrum is saved for all channel pairs. The file extension is
.mds.

Recall Plot Setup (PSET) …

These two menu items provide a means of saving [or recalling] the current plot condition, such as window
locations and window content, including: channel numbers, function type, axis-type, and range.  These files
can be recalled at a later date to process customized plot conditions.

Without user intervention, the plot setup file is automatically saved with .mds, .dsc, and .thd files.

You can have plot setups automatically recalled whenever you recall data files.  To select this
option, open the Preferences window [accessed through the Edit pull-down menu] and check
the box labeled “Recall Plot Setup When Recall Data Files.”

Print

The standard print window associated with your specific computer will open.  Select a printer and the
number of copies needed before clicking <OK>.

Note: In regard to printing, black plot backgrounds changed to white.

Authorization

Provides a means of enabling additional view features that are available with purchased software, i.e.,
eZ-TimeView and eZ-FrequencyView.  Aside from a trial period, an authorization code is required to enable
the applications available features.  eZ-TimeView, eZ-FrequencyView, and the eZ-Analyst program from
which they were derived are discussed in the document, eZ-Analyst Series Software Reference,
p/n 1086-0922.

Exit

This menu item closes the eZ-PostView application.



2-4      Menus and Windows 09-05-02 eZ-PostView

Edit Menu

The Edit Menu provides a means of configuring eZ-PostView in regard to both functionality and
appearance.  The menu contains the following selections, each of which is detailed in the subsequent
sections:

Configuration Window…… 2-4
Playback Setup Window…… 2-7
Window Colors Window…… 2-8
Preferences Window…… 2-9

Edit Menu  > Configuration Window
The Configuration item provides a means of changing the majority of eZ-PostView settings in regard to
determining how the data is manipulated. The Configuration selection displays the Configuration Window
with one of several tab dialogs displayed.  Selectable tabs are:

Acquisition Tab…… 2-5
Input Channels Tab …… 2-6
Octaves Tab (the tab is present, but does not apply to eZ-PostView)
Miscellaneous Tab (the tab is present, but does not apply to eZ-PostView)
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Edit Menu > Configuration >                       Acquisition Tab

eZ-PostView’s Acquisition Setup Tab

Edit Menu > Configuration > Acquisition Tab:  Acquisition Panel
With respect to eZ-PostView, the Acquisition Panel provides “read-only” text pertaining to the following:

Sample Rate (samples per second)

Time Blocksize  (Acceptable blocksizes range from 128 to 16384 data points).

Time Delta X

Time Block

File Size in:
    seconds
    blocks
    disk space in MB
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Edit Menu > Configuration >                          Input Channels Tab

The Input Channels tab displays the setup conditions of the input channels as they were when the
acquisition was saved-to-disk.  Actual hardware setup can not be changed from eZ-PostView.  The grayed-
out columns, in the following figure, can not be changed from eZ-PostView.

Input Channels Tab Selected

No.: This column lists all available channels.  It can not be edited.

Active: Shows “ON” for input channels that were active during the acquisition.
The column can not be edited in eZ-PostView.

Label: This should be a meaningful channel name.  Highlight a cell before typing a label.
When you press the Enter key, the label is accepted.

Response
Reference

There are two types of channels, Response and Reference.  All channels are initialized as
Response channels.  The column can not be edited in eZ-PostView.

FSV: Full-Scale Voltage.  The cells in this column are used to set the FSV value in Volts.
This column can not be edited in eZ-PostView.

EU Mode: E(ngineering) U(nits):  Select EU or Volt.
This column can not be edited in eZ-PostView.

Units: Enter the measurement units you will be using.

Location: This is a simple numbering system.  The channel number is the default value for location.
However, you can highlight a cell and type a different location number.  When you press the
Enter key, the value is accepted.

Coord: This is the axial direction of the transducer that was connected to the channel.
This column can not be edited in eZ-PostView.

Input Type: This is the type of instrument that was attached to the channel.  Menu selections include:
Acceleration, Velocity, Displacement, Force, Pressure, Stress, Strain, General, and Tach
(Tachometer).  This column can not be edited in eZ-PostView.
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Edit Menu > Playback Setup Window

Edit Menu > Playback Setup Window:  Source Information Panel
There are no playback functions that can be setup from within the eZ-PostView application.
However, the window’s Source Information panel does provide general file related information
such as filename, file location, the number of active channels, sample rate, block size, the
number of blocks recorded, and recorded time.

The panel includes a Comments box for user remarks.

Playback Setup Window
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Edit Menu >                Window Colors

Plot Window Colors

Plot window defaults are:
Frame Border = Grey
Plot Background = Black
Grid Lines = Grey
Cursor = White

The four possible types of cursor are:
Single cursor
Second cursor of band cursors
Peak Search cursor
Data List

1. To change a Plot Window display color, click on the button that applies to the display characteristic,
for example, <Plot Background>.

2. Click <OK>.  The Color Palette will open.

Color Palette

3. Select a color by clicking on a color square, or by defining a Custom Color.

4. Click <OK>.

5. Repeat steps 1 through 4 for each Plot Window color that you want to change.

6. When finished, click <OK> in Colors [Color Palette] window.
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Edit Menu > Preferences Window

The Preferences window provides a mean of setting several acquisition-related processing options.

Preferences

Trace Colors: Defines colors for traces.  Click on a channel’s color chip to open a color palette.
Pick a new color, then click <OK>.

Labels Colors: Defines colors for on-plot text labels. Click on a color chip to open a color palette.
Pick a new color, then click <OK>.

Cursor Movement
Control:

Sets the cursor’s action.  Options are: Pick/Drag, Pick Only, and Drag Only.
Pick/Drag: Makes use of both the Pick Mode and the Drag Mode.
Pick Only: Clicking the left mouse button allows the cursor to move
instantaneously with the band cursor.  The chosen cursor moves to the location
when the mouse is clicked.
Drag Only: Move the mouse pointer to the cursor location.  The pointer will
change to a “Left and Right Arrow.”  Click and drag the cursor to the designated
location.

Cursor Peak Search: n/a

Peak Picking: n/a

Recall Plot Setup. . . If the box is checked, the custom plot setup will be saved (recalled) and will be
applied when the next time the associated data file is opened.
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Window Menu

Menu Items
Add Function View (FV) …… 2-11
Delete Window …… 2-11
Channel Buttons ……2-11
Cascade …… 2-12
Tile Vertically ……2-12
Tile Horizontally …… 2-13
Refresh Windows …… 2-13

Reference Note:

For information regarding the interactive features of Plot Display Windows, refer to chapter 3.
The interactive features are not selected from the Window Menu, but are accessed via mouse
buttons and/or hotkeys.

Window Menu  > Add Function View (FV)
This menu selection opens an additional plot window.

Example of an Added Function View

Window Menu  > Delete Window
Deletes the window that is currently in focus.  When multiple plot windows are open, one is always the
“focus window.  When a window does not have focus, its title bar is dimmed.  To change the “focus
window,” simply click on top or side border of the window of interest.

Window Menu  > Channel Buttons
Brings up a display showing squares for all channel buttons.  The buttons are used in the exact same
manner as the 16 channel buttons that are located on eZ-PostView’s main window, just below the
Date/Time region.

• To add a channel: use the mouse to click and drag a channel box from the complete channel button
display into the plot area.

• To remove a channel: use the mouse to click and drag a channel box (from the right-side of the plot)
into the plot area.
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Window Menu  > Cascade
When you have multiple plot windows open, this menu selection arranges them on you screen as shown.

Example of using Cascade with three Plot Windows

Window Menu  > Tile Vertically
When you have multiple plot windows open, this menu selection arranges them on your screen as shown.

Example of using Vertical Tile with two Plots
Each plot is longer in the “vertical” direction.
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Window Menu  > Tile Horizontally
When you have multiple plot windows open; this menu selection arranges them on your screen as shown.

Example of using Horizontal Tile with two Plots
Each plot is longer in the “horizontal” direction.

Window Menu  > Refresh Windows
Used to refresh a window; for example, to refresh a Strip Chart.  In this case, the refresh function blanks
out the present Strip Chart, essentially providing you with a new, clean window.
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Interactive Features of eZ-PostView’s Plot Display Window 3

How to Change Plot Display Characteristics ……3-2

How to Change “Focus” …… 3-2

How to Add and Remove Channels …… 3-2

Other Features …… 3-3

Copy …… 3-3
Cursor …… 3-3
Label / List …… 3-4
Changing the Display Range …… 3-5
Changing the Plot’s Format / Scale / Grid …… 3-6
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How to Change Plot Display Characteristics
To change a plot’s display characteristics; it must be the “focus plot.”  Then, you can either use the mouse
or key commands to make changes.  “Focus” is explained in the following section.

Open Plot Display Characteristics Menu:  Press “D” or right click with the cursor
hovering over the plotted data.

Use the down arrow key to highlight a menu option, then press “Enter”.  Note that in
some cases you can press the first letter of an option to open its sub menu, for example,
pressing the “S” key opens the Scale Type sub menu.

Two Plot Windows
 In this figure, the upper plot has the “focus.”

How to Change “Focus”
Focus can refer to the window that is in focus, as well as to a plot that is in focus.  When multiple plot
windows are open, one is always the “focus window. ”  In the following figure, the window with the dark
title bar (top window) is the window that currently has “focus.”  When a window does not have focus, its
title bar is dimmed.  To change the “focus window,” simply click on top or side border of the window
of interest.

When multiple plot windows are open, a plot other than the one in the “focus” window can be the “focus
plot.” You would typically do this when you want to change a plot’s characteristics.  To change the “focus
plot,” click in the plotted area of the window of interest.  Note that the window must be in focus at the
time.

How to Add and Remove Channels

To add a channel to a plot . . .
With your mouse, click and drag a channel box
from above the plot to the plot area.

To remove a channel from a plot . . .
With your mouse, click and drag a channel box
from the right of the plot into the plot area.

To ADD a channel, click-on the desired “channel box”
in this area and drag it into the plot region.

To REMOVE a channel, click on the
desired “channel box” in this area and
drag it into the plot region.
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Other Features

Copy

To Open the Copy Menu:  Press “D” + “C,” then release the keys.
The Copy selection will be highlighted. Press “Enter.”
Next, use the down arrow key to select the item you desire to
copy: Data, Plot Window, or Screen, then press “Enter.”

You can paste the copied item into other applications.  For
example, plotted data can be copied into Notepad, Word, or Excel
for use in reports or in the case of Excel further calculations.

The plot window and full screen can be copied and then pasted
into any application that accepts graphics, such as MSPaint or
Word.

Plot Window Data
Copied and Pasted into Word

Cursor
To Open the Cursor Menu:  Press “D” + “C,” then release the
keys.  Then use the down-arrow key to highlight Cursor and press
“Enter.”

Next use the down arrow key to select, Cursor Off or Single
Cursor, then press “Enter.”

When Single Cursor is selected, a cursor appears at the far left of the plot and cursor controls and cursor
information are added below the plot.  Click on the plot where you want the cursor.  To fine-tune the cursor
location, use the right and left arrows at the bottom.  Use the X and Y information for additional help.  If
you have multiple channels in the graph, use the up and down arrows to move the cursor from plot to plot.
Press “C” to toggle the cursor on and off.

Plot Window with Single Cursor
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Label / List
To Open the Label/List Menu press “D” + “L,” then release the keys.
Label/List will be highlighted.  Press “Enter.”

Using the down arrow key, select Data or Text.   Then press “Enter.”

Data places up to 10 cursor values on your plot.  After you select data, a temporary cursor is placed on the
plot and the x, y data values are shown for that location.  As you move your mouse, the temporary cursor
will move across the plot with data values continuously updated.  When you have the cursor where you
want it, click on the mouse to place the label.  Another temporary cursor immediately appears.  When you
are finished labeling values, right-click and select Pointer to return to a normal state.

Adding Data Point Cursors and Text

Text places a comments text box on the plot.  After you select text, click on the plot and start typing.  You
are limited to 26 character places.  Click on the right corner of the text box to move it anywhere on the plot
window.

Data
Cursor

Text

Data
x and y
values
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 Changing the Display Range
To change the maximum or minimum range value:  Left-click on upper or lower scale value that is to be changed, then
enter the new value.  An example follows.

To change the X-Axis:  Hold down the <Ctrl> key, at the same time, left-click and drag the mouse cursor horizontally on
the plot.  Two vertical cursor lines will define the new x-axis end points.

To change the Y-Axis:  Hold down the <Alt> key, at the same time, left-click and drag the mouse cursor vertically on the
plot. Two horizontal cursor lines will define the new Y-axis end-points.

To simultaneously change the X & Y Axes:  Hold down the <Ctrl> and <Alt> keys, at the same time, left-click and drag
the mouse cursor diagonally on the plot.  A rectangle will define the new area of the plot.

In this example, the cursor and PC
keyboard were used to change the
maximum scale value from 3.000 volts
to 3.800 volts.
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Changing the Plot’s Format / Scale / Grid
Right-Click on the plot’s border to open a popup menu (see figure).  If you want to change the y-axis, right-
click on the plots left border.  If you want to change the x-axis, right-click on the plot’s bottom border.

Changing the plot Format, Scale, or Grid affects the display only.
It does not change the real data.

Format

The Format menu allows you to change the axis format of the plotted data.

Scale

The Scale menu allows you to change the plot scale to AutoScale, FixedScale, or Manual.
Autoscale ensures that all the captured data is visible on the plot.

Grid

The Grid menu allows you to place and remove grid lines from the graph of plotted data.  You can also turn
the grid on and off by pressing the “G” hot key.
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Note:

Appendix A, taken from the eZ-Analyst Series Software Reference Manual, p/n 1086-0922, consists of
several hot key tables for the benefit of those who prefer to use keys in place of mouse/cursor interaction
with a GUI.

Although eZ-PostView was derived from eZ-Analyst, certain key functions will not apply, for example,
the keys pertaining to Measurement, Scope, and Generator Control.
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Appendix A - Keyboard Controls for eZ-Analyst                     A

This appendix consists of several hot key tables for the benefit of those who prefer to use keys in place of
mouse/cursor interaction with a GUI.  However, for certain functions, such as changing axis scales, a
mouse will be needed.  Mouse use is pointed out in the tables, when applicable.

Record / Playback Control

Keys Function Comments

p Play Forward -----

<Shift> + p Play Backward -----

o Step Forward and Record -----

<Shift> + o Step Backward and Record -----

H Halt Playback -----

Measurement, Scope, and Generator Control

Keys Function Comments

H Halt the measurement -----

R Start recording -----

S Start Scope Mode (Measurement) -----

W Turn the signal generator On -----

Menu and Window Control
Keys Function Comments

Presents the Edit Menu. -----

Presents the Plot Window Colors window. After pressing Alt + E to access the Edit
Menu, press C to get the Colors Window.
Use the Tab key to select a characteristic,
then hit <Enter>.

Presents the Configuration window. After pressing Alt + E to access the Edit
Menu, press M to get the Configuration
Window. You will need a mouse to access
all panels.  Also, see Ctrl + M.

Alt + E …

           … C

           … M

           … P Presents the Playback Setup window. After pressing Alt + E to access the Edit
Menu, press P to get the Playback Setup
Window.  Use the Tab and arrow keys to
make selections within this window.  Then
hit <Enter>.

Alt + F Presents the File Menu. -----

Alt + W Presents the Window Menu. You will need a mouse to make
selections.

Ctrl + M Presents the Configuration window. You will need a mouse to access all
panels.  An alternative to Ctrl + M is to
press M when the Edit Menu is open.

Ctrl + O Presents the Open File Dialog window. From within the window, use the Tab and
arrow keys. An alternative to Ctrl + O is to
press O when the File Menu is open.

Ctrl + P Presents the Print Dialog window. An alternative to Ctrl + P is to press P
when the File Menu is open.

D Presents the Display Menu, also referred
to as the Plot Display Characteristics Menu.

Refer to the following table for control
options related to the Display Menu.
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Display Menu Control
Keys Function Comments

D Opens the
Plot Display Characteristics Menu

Option:  “Right-clicking” the mouse, while
the cursor is over the plot will also open
this menu.

Used to open the
Complex Type Display Menu.
This option is only available when a function
with complex data is displayed.  Menu
choices are: Magnitude, Phase, Real,
Imaginary, Magnitude + Phase,
Real + Imaginary, and Nyquist

Press D + C; release, then press <Enter>.
The Complex Type Display Menu will
open. Use the arrow keys to highlight the
type of display, then press <Enter>.

Used to open the Copy Menu.
Menu choices are: Data, Plot Window,
Screen.

Press D + C; release, then use the arrow
key to select Copy.  After selecting Copy,
press <Enter>.

D + C
(3 functions)

Used to open the Cursor Menu.
Menu choices are: Single Cursor,
Band Cursor, or Cursor Off.

Press D + C; release, then use the arrow
key to select Cursor.  After selecting
Cursor press <Enter>.

D + F Opens the Display Functions Menu.
Note that right-clicking on the plot will also
open this menu.

Use arrow keys to highlight your selection,
then press <Enter>.  In some cases you
can select the first letter of an option to
select it.

D + I Opens the
Integration/Differentiation Menu.

Use arrow keys to highlight your selection,
then press <Enter>.

D + L Opens the Label / List Menu. Use arrow keys to highlight your selection,
then press <Enter>.

D + O Opens the Octave Menu. Use arrow keys to highlight your selection,
then press <Enter>.

D + S Opens the Scale Type Menu.
Menu choices are RMS, Peak, Pk-Pk.

Use arrow keys to highlight your selection,
then press <Enter>.

D + T Opens the Transfer Type Menu. Use arrow keys to highlight your selection,
then press <Enter>.

Plot Display Controls  (Note)

Keys Function Comments

Mouse-Click
Bottom
Border

Change the X-axis in regard to format, scale,
and grid.

Right-click on the plot’s bottom border to
access a menu for changing the X-axis in
regard to Format, Scale, and Grid.

Mouse-Click
Left Border

Change the Y-axis in regard to format, scale,
and grid.

Right-click on the plot’s left border to
access a menu for changing the Y-axis in
regard to Format, Scale, and Grid.

, Moves the primary cursor left along the trace. When in Band Cursor mode, the comma
moves the primary cursor to the left.

. Moves the primary cursor right along the
trace.

When in Band Cursor mode, the period
moves the primary cursor to the right.

< Moves the secondary cursor left along the
trace.

When in Band Cursor mode, the “<”
moves the secondary  cursor to the left.

> Moves the secondary cursor right along the
trace.

When in Band Cursor mode, the “>”
moves the secondary  cursor to the right.

<shift> Peak search. Press the <shift> key while depressing the
left mouse button to search for peaks
along the trace.

Note:  Also see the Display Menu Control Table.                                                                                                   Continued

Reference Note:  For more detailed information, which includes graphics, refer to
chapter 3, Interactive Features of the Plot Display Window.
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(continued)

Plot Display Control     (Note)

Keys Function Comments

A Turns Auto-scale On. -----

Alt Expands or contracts the Y-Axis. (a) While holding down the <Alt> key,
place the cursor at the desired start point
of the Y-axis, (b) click the left mouse
button, (c) drag the mouse vertically until
the cursor is at the new end point of the
scale.

b Bank up. -----

<shift> + b Bank down. -----

C Toggles the cursor On or Off; or cycles the
cursor options as follows (if Band Cursor is
selected): Adds a Cursor, Adds a second
Cursor, turns both cursors Off.

When Band Cursor is selected, the “C”
key cycles through On (add a cursor), add
a second cursor, and Off.

Ctrl Expands or contracts the X-Axis. (a) While holding down the <Ctrl> key,
place the cursor at the desired start point
of the X-axis, (b) click the left mouse
button, (c) drag the mouse horizontally
until the cursor is at the new end point of
the scale.

Ctrl + Alt Simultaneously expands [or contracts]
both the X and Y axes.

(a) While holding down both the <Ctrl>
and <Alt> keys, place the cursor at the
desired start point on the plot, (b) click the
left mouse button, (c) drag the mouse
diagonally until the cursor is at the new
end point of the scale.

Zooms in or out. When you depress one of these keys,
while dragging with the right mouse
button depressed, you will zoom in or out,
according to the cursor-defined region.

F2 or Z
(2 functions)

Pan along the X-axis, Y-axis, or both. By depressing one of these keys, while
dragging with the left mouse button
depressed, you can pan in the direction of
the drag.

F3 Zoom in or out. Use F3 with the left mouse button to zoom
in our out.

G Turns Plot Grid On or Off. Toggles the grid to On or Off.

L Changes the Scale to Linear or to Log. Toggles the scale to Linear or to Log.

R Start Recording -----

S Start Scope Mode (Measurement) -----

X Presents the X-Axis Menu -----

Y Presents the Y-Axis Menu -----

Z or F2 Zooming or Panning. See “F2.”

Note:  Also see the Display Menu Control Table.

Reference Note:  For more detailed information, which includes graphics, refer to
chapter 3, Interactive Features of the Plot Display Window.
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